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14. SES DOSYALARI VE ANİMASYONLARIN WEB’E TRANSFERİ 

14.1. Sesler 

Yapılan animasyonların daha etkili olması istenirse mutlaka ses eklenmelidir. 
Menü çubuğundaki File > Import seçeneği işaretlenerek ekrana gelecek pencereden 
bir ses eklenebilir. Bu sesler windows'un altında bulunan hazır sesler, WAVE veya 
AIFF uzantılı sesler, flash'ın ses kütüphanesinde bulunan sesler veya Import edilen 
ses dosyaları olabilir. Ses dosyaları sadece keyframe'lere eklenebilir. Örneğin : Bir 
tween yapıldı ve ses bu tween'in ortasında kullanılmak isteniyor. Normal şartlarda 
ses dosyası filmin ortasına eklenemez. Ancak sesin başlayacağı yere bir keyframe 
eklenerek tweening bozulmadan ses ortadan başlatılabilir. Eklenen ses dosyasının 
boyutu ile animasyondaki yeri çok önemlidir. Çünkü eklenen ses dosyası iki keyframe 
arasına sıkışır. Eğer iki keyframe arası bir kaç frame'den oluşuyorsa; oraya uzun bir 
ses dosyası eklemek istenirse, animasyon bittikten sonrada ses devam eder. Bu 
yüzden sesler iki keyframe arasını mutlaka dolduracak şekilde eklenmelidir. Örnek 
olarak Import edilen herhangi bir sesi kütüphaneden tutup sürükleyerek animasyonun 
üstüne ekleyin. Bunu yapabilmek için zaman ekseninde herhangi bir keyframe'in 
üzerinde olunması gerekir. Ve o keyframe'in üzerine sağ tıklayıp properties’i, oradan 
da sound sekmesini tıklayın. Ekrana gelecek pencere aşağıdaki gibidir.  

 

 
Şekil 14.1.1. Ses Dosyası Özellikleri 
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Sound alanı animasyona eklenilen dosyanın ismini belirler. Hemen sağındaki 
ok'a basarak kütüphanede yer alan diğer seslerde görülebilir. Effect yazısının 
üstünde kalan bilgiler ses dosyasına ait bilgilerdir. Pencerede, üstüste iki adet ses 
dosyasını gösteren pencere bulunur. Üstteki sol denge, alttaki ise sağ dengeyi 
kontrol eder. Onların altında içi dolu bir kare ile bir üçgen vardır. Üçgen ses 
dosyasının çalışmasını sağlar. Kare ise durdurur. Onların yanında ise büyüteç 
aletleri, saat ve frame'leri tabir eden simgeler bulunur. Büyüteç yardımı ile dosyanın 
görünüşünü büyültüp küçültebiliriz. Saat simgesine basıldığında sol ve sağ 
dengelerin arasında kalan eksenin birimi zaman birimi olur. Hemen sağındaki simge 
ise eksenin birimini frame cinsine çevirir. Yani hangi frame'de başlayıp hangi 
frame'de biteceğini görebiliriz.  

Şimdi Sol ve Sağ dengeler üzerinde duralım. Pencere ilk kez açılıyorsa, 
dengeler üzerinde kuşatma noktası tabir edilen noktalar olmaz. Ancak kuşatma 
çizgileri ikisinde de üst tarafta mevcuttur. Kuşatma çizgilerinin herhangi birine 
tıklarsanız, hem altta hemde üstte, kuşatma noktaları çıkacaktır. Bu noktaları 7 adete 
kadar çıkarabilirsiniz. Kuşatma noktalarını silmek için tutup dışarı doğru sürükleyin. 
Dedik ki kuşatma çizgisi başlangıçta üstte yer alır. Bu hem sol hem de sağ dengenin 
ses düzeyinin normal olduğunu belirtir. Eğer çizgiyi aşağılara doğru çekerseniz, ses 
düzeyi azalır. Noktalar yardımı ile sesi bir sağa bir sola götürebilirsiniz. Yukarıdaki 
şekilde; ses soldan azalarak, sağdan ise çoğalarak çıkacaktır. Ortada yer alan 
eksenin iki ucunda kaydırma çubukları bulunup, bunlarla sesin başlangıcını ve 
sonunu değiştirebilirsiniz.  

Yan tarafta bulunan Effect seçeneği aslında bizim de, çok rahatça 
yapabileceğimiz hazır efektler verir. Sync. ise dört adet seçenek sunar bize. 
Bunlardan birincisi (event) sesi olduğu gibi çalmasını sağlar, yani sesi hiç kesmeden 
(animasyon bitse bile) çalar. İkincisi (start), sesin başlangıç noktasını söyler. Bu 
ancak bir keyframe'de olabilir. Sesin sonunu ise üçüncüsü yani stop seçeneği söyler. 
Bunun içinde keyframe gereklidir. Dördüncüsü (stream) ise sesin iki keyframe 
arasında kalan bölümünü çalar. Onların altında kalan Loop seçeneği bize sesi 
animasyonda kaç kez çalacağımızı belirtir. Bu rakam ister iki olsun ister ikibin olsun 
dosyamızın boyutu değişmez. Eğer animasyonumuza, sürekli olarak çalacak bir ses 
dosyası ekleyeceksek, sesin mutlaka "Loop" özelliği olması gerekir. Yani bir döngü 
içinde çalınırken başlangıç ve bitişlerde aksamaması lazımdır. 

Ses açık ve ses kapalı seçeneği olan bir animasyon yapalım. Elimizde hazır 
bir animasyon yoksa basit bir animasyon yapın. Şimdi ister yazı ile sesi kapat 
yazalım, isterse bunu ifade edecek bir şekil çizelim. Sesi kapat yazısını seçip F8'e 
basarak movie clip yapalım. Birde ses açık komutu olacağına göre F6 ile bir 
keyframe daha ekleyelim. Sonrada ikinci keyframe'de bulunan yazımızı çift tıklayıp 
"kapat" kısmını "aç" olarak değiştirelim. Sonrada bunları ayrı ayrı button'a çevirelim 
(yine F8'e basarak). Şimdi de her iki keyframe'e bir ses dosyası ekleyelim. 1. 
keyframe'de çift tıklayıp properties'i açalım ve Actions kısmına Stop değerini verelim. 
Sound sekmesini tıklayıp Sync. kısmına Start, Loop kısmına da 2000 yazalım. 2000 
sayısı bu dosyanın boyutunu değiştirmez sadece sesin 2000 kez çalıp kapanmasını 
sağlar. 2. keyframe'e de Actions'tan Stop, Sound sekmesindeki Sync. kısmına da 
Stop yazıp kapatalım.  
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Şimdi sıra iki yazının birbirlerine verilecek link'e geldi. "Sesi kapat" yazısının 
üstüne sağ tıklayıp properties'ten Actions sekmesini açın ve artı işaretine basarak 
GoTo deyin. Frame number kısmına da 2 yazın ki tıklandığında 2. frame'e gitsin. Sesi 
aç kısmını da aynı şekilde yapıp bu sefer frame number'a 1 yazın. Artık ses kontrol 
ziyaretçinin elinde. Mesela aşağıdaki fan sesinden rahatsız olduğunuz gibi 
kapatabilirsiniz.  

 
Şekil 14.1.2. Ses Dosyası Örneği 

Eğer ses dosyası olarak MP3 kullanılmak istenirse, o zaman dosyayı bir kaç 
işlemden geçirmek gerekmektedir. İlk önce Winamp programınızı açın. CTRL+P'ye 
basarak "Preferences"ı açın. Sol taraftaki seçeneklerden "Output" seçeneğini tıklayın. 
Sağ tarafta şimdi birkaç tane seçenek görünecektir. Bunlardan "Nulsoft Disk Writer 
Plug-in" seçeneğini çift tıklayın. Karşınıza "Directory" isimli bir pencere açılacaktır. Bu 
MP3 dosyalarımızı WAVE olarak nereye ekleyeceğimizi belirtecektir. Herhangi bir 
klasör seçtikten sonra, artık istediğimiz parçayı belirttiğimiz yere kaydedebiliriz. 
Şarkımızı seçtikten sonra play düğmesine basıp kaydedebiliriz. Ama bu işlemi çok 
hızlı bir şekilde yapacağından, kaydetmek istediğimiz bölümü önceden belirleyip 
kaydırma çubuğunu oraya getirip hemen stop'a basmalıyız Kaydetme işlemi bittikten 
sonra Flash'ı açıp sesi kullanalım. Sesi Import ettikten sonra CTRL+L'ye basıp 
kütüphanemizi açalım. Ses dosyamızın üstüne çift tıklayıp açılan pencerede "Export 
Settings" kısmını MP3 yapıp kapatın. 

14.2. Düğme Yapımı 

 Button semboller yani düğme sembolleri flash animasyonlarımızda interaktivite 
katmak için kullanılırlar. Yaratılan düğmeler kullanıcıyı başka animasyonlara 
götürmek, bir web sitesine gitmek, bir ses çıkarmak yada animasyonda birşeylerin 
gidişatını değiştirmek için kullanılır. Bir düğme yaratmak dört frame'lik bir animasyon 
yaratmak kadar basittir.  

CTRL+L basıp Library Inspector'u çağırın. Optios'dan new symbol seçin yada 
library penceresinin sol alt köşesindeki artı ikonuna tıklayın. Sembolunüze bir isim 
verin ve "Behaviour" (davranış biçimi) olarak "button" seçin OK'ye basın. Karşınıza 
ortasında bir artı olan boş bir stage çıkacaktır. Timeline'da düğmenin durumlarını 
temsil eden sadece dört frame olduğuna dikkat edin (Şekil 14.2.1.)  
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Şimdi buttonu çizebilirsiniz. Kolaylık olsun diye "view > grid" ile sahneyi 
karelere bölelim. "view > snap" ile çizdiklerinizin bu karelere yapışmasını 
sağlayabilirsiniz. Dikdörtgen çizme aletini seçin. Biraz daha şık olması bakımından " 
round rectangle radius" modifieri seçin. 15 ila 20 arasında bir değer girin. Daha sonra 
istediğiniz renkte bir dikdörtgen çizin. Text aletini seçin ve dikdörgenin ortasına kalın 
yazı ile uygun bir boyutta " bana tıklayın" yazın. Şu haliyle düğmemizin birinci 
durumunu (up / yukarı) yapmış oldunuz. Düğmelerin up/yukarıda dışında üç durumu 
daha vardır.  

 Bunlar sırası ile "over / üzerinde", "down / aşağıda" ve "hit / vuruş". 
Overframe'inde bir obje varsa, düğme çalışıyorken fare imleci üzerine geldiğinde, 
belirlenen görüntü gelir. Başka bir deyişle normal bir web sitesinde mouseover 
scriptinin yaptığı şey yapılır. Tabiki bunun için overframe'ine öncelikle bir keyframe 
yerleştirmeniz gerekiyor. Overframe'in üzerinde iken sağ tıklayın ve "ınsert keyframe" 
seçin. Şimdi aslında önümüzde sonsuz seçenek var. Ama tavsiyemiz karşınızdaki 
dikdörtgenin sadece rengini değiştirmeniz.  

"down/aşağıda" durumunda ise düğmeye basıldığı andaki görüntüyü verir. 
Düğmeye basılmış hissi verebilmek için yine sonsuz seçenek bulunur. Biz yine 
dikdörtgenin rengini değiştireceğiz. Bunu yaparken, az önce olduğu gibi "down" 
frame'ine bir keyframe yerleştirmek durumundasınız. "Hit/vuruş" frame'i düğme olarak 
tasarladığınız nesnenin hangi bölümünün, düğme özelliklerinden faydalanacağı alanı 
belirtir. Yani çizdiğiniz bir dörtgenin sol yarısını düğme olarak kullanmak isterseniz, 
sadece bu alanı kapsayacak kadar bir dörtgen çizmeniz gerekir.  

 Eğer bu frame'e birşey çizmezseniz, ilk frame'de olan resmin tümü düğme 
olarak kullanılır. Bu alana yapacağınız çizimlerin hiçbirisi normal animasyonda 
görünmez. Başka bir deyişle "hit" frame'inde, düğmeye kendi kapsadığı alan dışında 
bir etki alanı, bir sıcak bölge tanımlayabiliyorsunuz. Şimdi artık düğmemizi 
kütüphanemizden çıkarıp sahneye atabiliriz. CTRL+ ENTER'a basarak düğmeyi test 
edebilirsiniz.  

 

Şekil 14.2.1. Ses Dosyası Örneği 

14.2.1. Düğmeler ile Etkileşim 

 Düğmeleri yaptıktan sonra şimdi onlara anlam katalım. Planımız önce bir 
menü hazırlamak. Bu menüde iki seçenek yani iki düğme olacak. Birinci düğmeye 
basıldığında birinci animasyon, ikinciye basıldığında ikinci animasyon gösterilecek. 
Sonra animasyonun altında bir geri tuşu çıkacak ve ona basılıncaya kadar 
beklenecek. Basılınca menüye geri dönülecek. Bunu yapabilirseniz artık bir web 
sitesi yapmak için gerekli çok şeyi öğrenmiş olacaksınız.  
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Motion tween için yaratılan objeleri sembollere çevirmek (Inspect > Convert to 
symbol), shape tweening içinse tam tersi, sembol yada grup'larsa "break apart" 
(grubu seçip " modify > break apart yada "modify > ungroup", belki de birkaç kez) 
yapmak gerekir. Şimdi yeni bir döküman açalım. Bir de scene inspector'u açıp 
("windows>inspector>scene inspector") add düğmesine basarak iki yeni scene 
ekleyelim. Birinci animasyonun tüm timeline'ını bütün layer'larla birlikte seçip sağ 
tıklayıp "copy frames" yapalım. Sonra açtığımız yeni dökümanda scene 2'ye geçip, 
timeline'de birinci frame üzerinde sağ tıklayıp "paste frames" yapalım. Scene 3'e de 
ikinci animasyonun frameslerini kopyalayalım. Sonra library ınspectordan yeni iki 
sembol isteyip iki düğme hazırlayalım. Bu düğmeleride scene 1'e yerleştirelim. 
Düğme için, "libraries > buttons" dan hazır düğmeler bulup kullanabilirsiniz. Başka bir 
dökümanda yaptığınız düğmeleri kullanmak isterseniz, "file > open as library" 
komutunu o flash dosyasının bütün kaynaklarını bir library penceresinde açıyor. 
Buradan tutup kullanabiliyorsunuz.  

Sıra geldi beklenen interaktiviteyi yaratmaya. Birinci scene yani iki düğmenin 
durduğu scene gösterildikten sonra beklenmesini istiyoruz. Bu scene'in son 
keyframe'inin ki sadece düğme koyduğumuz için bir adet keyframe var. Properties 
penceresinde actions kulakçığına tıklayın. Dikkat edilmesi gereken şeylerden biride 
hem stage'deki objelerin, hemde frame'lerin action özellikleri olabiliyor. Şimdi 
karşınızdaki penceredeki artı düğmesine basın ve "stop" u seçin. Böylece yeni bir 
emir gelene kadar scene 1'de bekliyoruz. Bu emri uygulamasaydık scene1,2 ve 3 
sırayla gösterilecekti. Düğmelerin bağlantılarını da yapalım. Birinci düğmeyi seçin ve 
properties'ine gelin. Actions'da artıya basarak bu sefer GoTo seçin. Yan tarafta çıkan 
pull down menüde scene 2'yi seçin. GoTo and play seçeneğinin işaretli olmasına 
dikkat edin. Aynı işlemi ikinci düğme ve scene 3 için yapın. Şimdi scene inspectordan 
scene 2'ye geçelim ve bu animasyonun sonuna bir geri dönüş düğmesi ekleyelim. 
Düğmeyi tercihen yani bir layer'a koyalım. Yeni layer yarattıktan sonra animasyonun 
son keyframe'inin hizasında düğme layer'ında da bir keyframe yaratalım. 
Koyduğumuz düğmeye de GoTo scene 1 emrini verelim. Animasyonun bittikten sonra 
beklemesi için son frame'e bir stop eklemeyi unutmayın. Ve aynı işlemi scene 3'deki 
animasyon için de yapalım. Ve CTRL + ENTER yapıp izleyelim.  

14.2.2. Animasyonlu Düğmeler 

Üç cins sembol vardır. Birincisi durağan bir grafik, ikincisi bir düğme, üçüncüsü 
ise animasyondur. Semboller başka semboller de içerebilir. Şimdi üzerine 
gelindiğinde veya basınca yada hiç birşey yapılmadığı zaman bile bir animasyon 
gösteren düğmeler tasarlayalım. Yukarıdaki bilgilerden tahmin edebileceğiniz gibi, 
böyle şeyleri düğmenin gerekli frame'ine başka bir sembol ancak bu sefer bir "movie 
clip" yerleştirerek yapıyoruz. Bu "movie clip" sembollerini de her zamanki gibi 
stage'de yaratıp yani sembol ekleme sahnesine kopyalayabilir yada sıfırdan sembol 
editöründe yapabiliriz. Az önce yaptığımız düğmeyi daha da şıklaştıralım. Şimdilik 
basit bir animasyon ekleyelim. Düğme basılı iken etrafında bir top dönsün. Düğmenin 
üstteki yuvarlatılmış dikdötgenin kenarını seçelim. CTRL + C ile kopyalayalım. Yeni 
bir sembol açalım. İsim verdikten sonra behaviour olarak "movie clip" vermeyi 
unutmayalım. Bu yeni sembolün ilk layerine bir adet top yerleştirelim.  
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Ve bu topuda bir sembol haline getirelim. Şu anda bir sembolün içine başka bir 
sembol yerleştirmiş bulunuyorsunuz. Şimdi yaklaşık 20 frame sonrasına bir keyframe 
koyalım. Sonra layer ismine sağ tıklayıp "Add Motion Guide" seçelim. Yeni bir layer 
oluşmuş olmalı. Bu layer seçili iken CTRL + SHIFT + V basarak "Paste in Place" 
yapalım. Bu komut, kopyaladığınız nesneyi ekranın neresinden aldıysanız oraya 
yapıştırıyor. Normal CTRL + V yaparsanız ekranın tam ortasına koyuyor ve sizi uzun 
uzun onion skinlerle herşeyi yeniden üstüste getirmek zorunda bırakıyor. Düğmenin 
kenarları şu anda top için motion guide olarak layerine yerleşmiş durumda olmalı. 
Motion guide'ın bir çizgi haline dönüşmesi için sol üst köşesinden bir parçayı silgiyle 
silelim. Şimdi birinci frame'e gidelim, topu tutup dikdörtgen çizginin başlangıcına 
yerleştirelim. ("view > snap" açık olmalı) sonrada son frame'e gidip sonuna 
yerleştirelim. Enter'e basıp topun dönüp dönmediğini kontrol edin.  

Sıra geldi dönen topumuzu düğmeye eklemeye. Timeline'ın sağ üst köşesindeki 
düğmeye basarak biraz evvel yaptığınız düğmeyi seçin. Yeni bir layer yaratın ve 
down frame'e gelin. Library'den dönen topu alıp stage'e taşıyın. Onion skinning ile 
tam dikdörgenin üzerine oturtun. Düğmenizi çalışırken görmek için bu sefer "Control 
> Enable Buttons"un açık olması yetmiyor. Mutlaka CTRL + ENTER basıp 
animasyonu test etmelisiniz.  

14.3. Web'e Transfer 

14.3.1. Web Ortamına Aktarma 

Yaptığınız animasyon bittiğinde, onu "swf" uzantılı olarak export etmek lazım. 
Ancak bu şekilde herhangi bir browser'a okutabiliriz. Ancak yaptığınız animasyonun 
birde "fla" uzantılı olan bir kopyasını kaydetmeyi unutmayın. Flash'ta menü 
çubuğundaki File > Export Movie'ye bastığınız zaman size nereye ve hangi isimde 
kaydedeceğinizi soran bir pencere çıkacaktır. Bunları belirttikten sonra "swf" uzantılı 
flash animasyonunuz hazır demektir. Eğer bir HTML editörü kullanıyorsanız işiniz çok 
basit. Mesela FrontPage için yaptığımız animasyon bir plug-in'dir, yani eklentidir. 
Menü çubuğundan Insert > Advanced > Plug-in'e basın. Karşınıza çıkacak 
pencereden, Browse yani gözat'ı tıklayın animasyonun yerini söyledikten sonra 
boyutlarını belirtin. Burada dikkat edeciğiniz bir şey var. Animasyonun boyutu ne 
kadar büyürse büyüsün dosyanızın boyutu değişmez, ancak ekran kartından 
doğabilecek sorunları da çözmez. Yani kullanıcının ekran kartının RAM kapasitesi 
düşükse animasyonu oynatmakta zorluk çekecektir. Bu yüzden animasyonu 
ergonomik kullanmak gerekir. Plug-in properties penceresindeki diğer seçenekler 
kenarlıklarla ve nereye yanaşık olacağı ile ilgilidir. OK düğmesine bastığınızda, 
sayfanızda elektrik fişine benzer bir şekil kalacaktır. Alttaki sekmelerden Preview 
sekmesine tıkladığınızda animasyonu izleyebilirsiniz.  
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Şekil 14.3.1.1. Web Editörün’de Animasyon Ekleme 

14.3.2. Link Verme 

a) Actions - Link Verme 

Flash ile başlı başına bir programla dili ile hazırlanabilen aksiyonlar sayesinde, 
sınırlarınızı zorlayacak animasyonlar oluşturabilirsiniz. Programın bu özelliğinden 
faydalanmak için, Actions menülerini kullanacağız. Aksiyonlar ya mouse ile 
etkileşince veya klavyeden bir tuşa basınca ya da animasyonun normal seyri 
sırasında, herhangi bir frame'e ulaşınca devreye girer. Bu yüzden hangi aksiyonu 
nereye vereceğimizi bilmemiz gerekir. Actions sekmesine tıkladığınız zaman iki 
bölümden oluşan bir pencere ekrana gelir. Sol tarafta, artı (+) işaretinizde basıp 
eklediğiniz komutların sırası ile listesi verilir. Sağ tarafta ise bu komutların modifier'leri 
ve ona ait çeşitli seçeneklerin bulunduğu bir pencere ekrana gelir. 

 
Şekil 14.3.2.1. Actions  Ekranı-1 
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b) Link verme 

Animasyonumuzda bazı düğmelere link vermek isteyebiliriz. Bunun için link 
vermek istediğimiz düğmenin üzerinde sağ tıklayıp (Instance Properties: neye actions 
verilmesi gerekiyorsa onun üzerinde sağ tıklamamız gerekir. Bu actions'ı button'a 
veriyoruz, frame'e değil.) properties'ten Actions sekmesine gelin. Artı'ya basıp "Get 
URL" seçeneğini işaretleyin. Yan taraftaki URL penceresine "http://" ibaresini de 
yazarak link vermek istediğiniz adresi yazın. Sol taraftaki listede "On" seçeneğinin 
üstüne gelin. Şimdi sağ tarafta "Event" başlığı altında bir kaç seçenek çıktı. 
Bunlardan  
"Press"; düğmenin üzerinde tıkladığınız zaman, 
"Release"; düğmenin üzerinde tıklayıp bıraktığınız zaman, 
"Release Outside"; düğmenin üzerinde tıklayıp, dışarda bıraktığınız zaman, 
"Roll Over"; düğmenin üzerine geldiğiniz zaman, 
"Roll Out"; düğmenin üzerine gelip, dışarı çıktığınız zaman, 
"Drag Over"; düğmenin üzerinde tıklayıp, dışarı çıkıp tekrar düğmenin üzerine geldiğiniz 
zaman (tıklamayı bırakmadan), 
"Drag Out"; düğmenin üzerine tıklayıp, dışarı çıktığınız zaman, 
"Key Press"; klavyede belirteceğiniz bir tuşa bastığı zaman, 
 

verdiğiniz URL'ye gider. Aslında yukarıdaki listeyi iyice öğrenmekte fayda var çünkü 
bu işlemi sadece link vermede kullanmayacağız. URL penceresinin hemen altında 
"window" kısmında URL'nizin hangi browser penceresinde açılacağını 
bildiriyorsunuz. "_self" aynı pencereye, "_blank" yeni boş bir pencereye açıyor. Eğer 
frame kullanıyorsanız (animasyon frame'i değil HTML frame'i) frame adını elinizle 
girmeniz gerekir. Variables kısmı şimdilik bize yaramıyor. Tüm işlerimiz bittiyse 
Actions penceresi aşağıdaki gibi olacaktır.  

 

 

Şekil 14.3.2.2. Actions  Ekranı-2 

Aşağıda, düğmenin event seçeneklerini gösteren Flash'ın yardım dosyasından 
alınmış animasyon bulunmaktadır. Animasyonu bularak inceleyiniz.  
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Şekil 14.3.2.3. Düğmenin Event Seçenekleri Flash Yardım Dosyası Örneği 

 


